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1. Introduction  
 

Keysight-EEsof a développé un groupe de systèmes pour la simulation et l'analyse 

précises des éléments distribués et des discontinuités typiquement trouvées dans la 

conception de circuits MIC (Microwave Integrated Circuit ), MHMIC (Monolithic 

Hybrid Microwave Integrated Circuit), MMIC (Microwave Monolithic Integrated 

Circuits) et PCB (Printed Circuit Board).  

 

Parmi ces systèmes, ADS aide les concepteurs de circuits micro-ondes dans l'explication 

des effets physiques et l’évaluation des performances de leurs circuits. Il est spécialement 

développé pour simuler le chemin entier d'un signal de communication. En effet, il 

intègre une large variété d'outils de conception de circuits radiofréquences, de traitement 

de signaux numériques (DSP, Digital Signal Processing) et d'électromagnétismes dans un 

seul environnement flexible.  

 

Dans ce document, on présente une vue d'ensemble de l'environnement de ADS 

permettant de faciliter l'utilisation des outils offerts. Nous proposons, à titre d’application 

à la fin, un exemple de design d’un filtre puis d’un amplificateur à faible bruit en mettant 

en évidence les principales étapes à suivre pour accomplir ce travail.  

 

2. Environnement de conception  

 
L'environnement de ADS est basé sur des fenêtres. Toutes les opérations offertes se 

déroulent à l'intérieur de cadres dont on distingue quatre types:  

 
2.1 Fenêtre principale 

 

Elle contient la barre de titre avec son nom (Advanced Design System), la barre du menu 

et des barres d'outils pour un accès rapide aux opérations les plus communes. En plus, 

elle fournit un affichage de l'arborescence des répertoires compris dans les projets de 

conception.  

À partir de la fenêtre principale, on peut :  

• Créer et gérer des projets et des designs.  

• Initialiser les préférences.  

• Changer la configuration des barres d'outils et les raccourcis du clavier.  

• Changer le type de composantes chargées au démarrage.  

• Play-back des macros créés à partir du langage d'extension des applications 

(AEL).  

• Déclarations des commandes AEL.  

• Lancer l'éditeur de texte.  

• Ouvrir une fenêtre d'affichage de données.  

 

2.2 Fenêtres de conception (design window) 
 

L'environnement de conception est un environnement graphique pour la création, la 

simulation, l'optimisation et la documentation des systèmes RF, DSP et photoniques. Il 
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fournit une fenêtre pour l'intégration et la saisie des designs pour les exporter dans les 

autres modules de ADS tel que le "Layout" et les bibliothèques de modèles et de designs. 

La saisie des designs des systèmes RF, DSP et photonique se fait à l'intérieur d'une page 

schématique qui offre un menu déroulant et une barre d'outils qui peuvent être 

personnalisés. Les composants peuvent être consultés à travers les palettes organisées 

d'une façon logique, des listes textuelles des bibliothèques ou une boite de dialogue pour 

l'exploration des bibliothèques. À partir d'une page schématique on peut spécifier, 

contrôler et lancer une ou plusieurs simulations.  

L'organisation de tous les fichiers associés à une conception sous forme d'un projet est 

automatiquement fournie par l'environnement de conception. Tous ces fichiers sont des 

fichiers textes de type Ascii disponibles dans les répertoires par défaut du système ou 

spécifiés par l'utilisateur.  

L'interface utilisateur a été conçue pour avoir le regard et la sensation des outils 

populaires du bureau de PC. Les barres d'outils, les palettes de composants, les icônes et 

les touches de raccourcis du clavier fournissent un accès facile aux fonctions 

fréquemment utilisées. Des éléments des systèmes et des circuits peuvent être choisis à 

partir des palettes et placés via la souris; ils sont insérés avec leurs paramètres sur la 

page, prêts pour la connexion par les lignes de connexion ou de transmission. Les 

paramètres des composants peuvent être édités sur l'écran en double cliquant sur la 

composante en question. Un plein service d'aide et de documentation en ligne est fourni.  

 
2.3 Fenêtre d'affichage de données (display window) 

 
Le module d'affichage de données permet la visualisation graphique des résultats de 

simulation comme ils apparaissent sur des analyseurs ou d'autres instruments. Ces 

graphiques peuvent être personnalisés avec un choix de marqueurs, de couleurs, de styles 

de ligne et de légendes. La présentation de données peut se faire sur des "plots" 

rectangulaires, polaires, abaques de Smith, des colonnes rectangulaires empilées et des 

listes. Selon les propriétés de données à visualiser, on peut choisir un des différents types 

de "traces" disponibles à savoir : courbes (Line), nuage de point (Scatter), histogramme, 

digital, spectral et bus (affichage des données binaires pour un bus de largeur d'au plus 

128 bits).  

 

Les "plots" peuvent être annotés avec une gamme complète des éléments de dessin, y 

compris des lignes, des rectangles, des cercles, du texte, des polygones, et des lignes 

formées de segments "polylines".  

 

Via l'utilisation du concept appelé "dataset", le module d'affichage de données permet le 

partage des résultats de simulation pour les visualiser ou les analyser de plusieurs 

manières. Les "datasets" maintiennent à jour la mémoire persistante des résultats de 

simulation de telle sorte qu'on peut retirer toutes les données liées à n'importe quel 

paramètre de simulation. Ainsi, on ne doit pas re-simuler pour créer une vue différente de 

données. Les résultats de différentes simulations stockées dans différents "datasets" 

peuvent être tracés dans une même fenêtre d'affichage de données afin de faciliter une 

comparaison.  
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La capacité de manipuler les données stockées dans les "datasets" moyennant des 

équations apporte une flexibilité dans l'étude des résultats de simulation. Les boites de 

dialogue montrent toutes les données disponibles pour aider à établir ces équations. 

Beaucoup d'expressions utiles, telles que des diagrammes de oeil, histogrammes, taux de 

puissance de canaux adjacents (Adjacent Channel Power Ratio), transformée de Fourier 

rapide (Fast Fourier Tranforms) et le taux d'onde stationnaire (VSWR, Voltage Standing 

Wave Ratio) sont incorporés.  

Le réglage automatique des échelles (autoscalling) des axes sur les "plots" est fourni pour 

permettre une meilleure visualisation de données. La graduation manuelle est également 

possible. Les marqueurs (markers) permettent d'obtenir des données relatives à n'importe 

quel point sur le "plot". Les marqueurs de type delta (Delta Marker) donnent les valeurs des 

points sur un "trace" par rapport à un point de référence du même "trace".  

 

2.4 Fenêtre de message et d'états 

 
Elles apparaissent lors du lancement du simulateur afin d'afficher l'état d'avancement du 

processus en cours ainsi que les messages d'avertissements.  
 

3. Simulateur linéaire  

 
La simulation de circuit linéaire dans le domaine de fréquence est employée pour 

analyser et optimiser les circuits RF et micro-ondes (par exemple, amplificateurs, 

oscillateurs, coupleurs, filtres, mélangeur) qui fonctionnent dans des conditions linéaires. 

La technologie peut être appliquée à la conception des circuits passifs et des circuits 

actifs excités par des petits signaux (small signal).  

 

Une fois que le circuit est dessiné, ce simulateur permet d'examiner la topologie 

automatiquement pour détecter les files et les broches non connectés. Le simulateur 

exécute alors toutes les mesures linéaires nécessaires telles que des paramètres S, Z, Y et 

H, l'impédance et l'admittance de circuit, des coefficients de réflexion et le VSWR, le 

gain, la perte, le bruit, le gain unilatéral, le délai de groupe, le facteur de stabilité, la 

mesure de stabilité et les cercles de stabilité, de gain et de bruit. En outre, le simulateur 

peut exécuter l'analyse avec un balayage de paramètre, telle que la figure de bruit vs le 

changement de l'impédance d'entrée du dispositif.  

 

Les bibliothèques étendues du simulateur contiennent une panoplie de modèles des 

dispositifs passifs et actifs petit signal nécessaires pour la conception à haute fréquence. 

Le simulateur peut également exécuter l'analyse linéaire avec les modèles non linéaires à 

un point de polarisation DC défini par l'utilisateur.  

 

La simulation via ADS est accomplie en plaçant un élément de contrôle dans la fenêtre 

du schéma du design. Les éléments de contrôle disponible varient selon le type du design 

courant.  

 

Parmi les catégories des éléments de contrôle pour chaque type de design, il y a:  

• Sources dans le domaine de fréquence (Frequency Domain Sources)  
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• Sources dans le domaine de temps (Time Domain Sources)  

• Sources de bruit contrôlé (Noise Controlled Sources)  

• Simulation DC  

• Simulation AC  

• Simulation des paramètres S  

• Simulation par équilibrage harmonique (Harmonic Balance)  

• Simulation des paramètres S large signal (LSSP Large signal S Parameters)  

• Simulation du gain de compression (XDB)  

• Simulation d'enveloppe (Envelope Simulation)  

• Simulation du régime transitoire (Transient Simulation)  

Une fois que l'élément de contrôle est placé, il faut choisir la commande Simulate 

>Simulate dans le menu principal. Si on désire spécifier le nom du dataset où on veut 

sauvegarder les résultats de simulation, il faut utiliser la commande Simulate > Setup.  
 

4. Le simulateur électromagnétique planaire Momentum  

 
Le simulateur électromagnétique planaire Momentum permet de se passer de l'incertitude 

de la conception physique en exécutant une analyse électromagnétique. Il est conçu pour 

analyser les géométries planaires multicouches. Ses résultats sont fournis sous forme de 

paramètres S. Ces derniers peuvent être utilisés directement dans les simulateurs de 

circuit tel que "Harmonic balance" et "Circuit Envelope". Ce simulateur est basé sur la 

méthode de moment qui est particulièrement efficace à analyser les géométries planaires 

de conducteur et de résistance. Les structures planaires composées de plusieurs couches 

diélectriques peuvent être reliées avec des vias. Les fentes peuvent être dessinées sur un 

plan de masse (Ground Plane) et leurs interactions sont efficacement résolues. Le 

maillage est appliqué aux fentes et non pas au plan de masse.  

 

Le module de "layout" est un éditeur graphique puissant qui permet la conception et la 

simulation physiques interactives des "layouts" des circuits RFIC, MIC, MMIC ou PCB. 

Les "layouts" peuvent être utilisées avec des solutions facultatives qui s'adressent 

spécifiquement aux problèmes de conception des circuits à haute fréquence afin de 

réduire les erreurs et terminent les conceptions plus rapidement. Comme l'éditeur des 

designs, l'éditeur des "layouts" permet de sélectionner un composant à partir d'une palette 

graphique de modèles de simulation.  

 

5. Démarrage du programme  
 

Sous Windows, le démarrage du programme se fait à partir du menu démarrer dans :  

All Programs>Advanced Design System 2020>Advanced Design System 2020.  

 

Il faut noter que pendant le premier démarrage de l'application, on peut choisir le type de 

composantes à charger: Analog/RF seulement, Digital Signal Processing seulement ou 

encore les deux. Le choix de l'une des deux catégories limite le choix de composantes 

dans la session courante à celle sélectionnée. Une fenêtre similaire à la fenêtre suivante 

s'affiche au démarrage de ADS.  
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6. Travailler avec un projet  
 

Dans ADS, la fenêtre principale permet de créer et de gérer les projets qui sont le centre 

d'opération de toutes les simulations.  
 

▪ Créer un projet:  

Tous les travaux de conception doivent se faire à l'intérieur du répertoire du projet. Cette 

structure prédéterminée est composée d'un ensemble de sous-répertoires qui contient les 

différents types de fichier. Ces sous-répertoires sont utilisés de la manière suivante:  

o networks: contiennent les informations relatives aux schémas et/ou aux layouts.  

o data: le répertoire contenant les fichiers de données, résultats des simulations.  

o mom_dsn: contiennent les designs créés par le simulateur EM planaire 

Momentum.  

o Synthesis: contiennent les designs créés par le filtre DSP et les outils de synthèse.  

o Verfications: contiennent les fichiers générés par le Design Rule Chercker (DRC) 

utilisés avec les layouts.  

 

Pour créer un projet il faut:  

1. Choisir File > New Project et une boite de dialogue apparaît.  

2. Changer le chemin comme désiré et fournir un nom pour le nouveau projet.  

3. Si on travail avec l'option layout, il faut préciser l'unité de longueur à utiliser (mil, 

millimètre, micron). On travaillera en mil.  

4. Cliquer OK.  
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Par défaut, une fenêtre de schéma apparaît automatiquement quand on crée un nouveau 

projet.  
  

▪ Ouvrir un projet:  

L'ouverture d'un projet peut se faire en utilisant la structure d'arborescence disponible 

dans la fenêtre principale pour spécifier le répertoire qui correspond au projet. Ensuite, à 

partir de la commande View > Project listing on obtient la liste des projets 

disponibles. Un double clique sur le nom du projet désiré permet son ouverture. On peut 

procéder autrement en se servant de la boite de dialogue associée à la commande File 
>Open Project du menu principal en double cliquant sur le répertoire désiré et puis sur 

le nom de fichier visé.  
  

▪ Ouverture d'une fenêtre de design:  

Il y a plusieurs façons d'ouverture d'une fenêtre de design et la méthode adoptée est basée 

sur son utilisation.  

o Nouveau design: pour ouvrir une fenêtre de schématique ou un layout afin de 

créer un nouveau design ou éditer un design existant mais qui n'est pas en 

mémoire courante, il faut cliquer sur Window > New schematic ou New 
Layout dans la fenêtre principale.  

o Fenêtre additionnelle: pour ouvrir une fenêtre additionnelle de schématique ou de 

layout pour un design déjà en mémoire courante, il faut choisir la commande 

Schematic ou layout du menu Window de la fenêtre principale.  
 

Pour fermer une fenêtre de design, il faut choisir, File > close window.  
 

7. Travailler dans une fenêtre de design  
 

Une fenêtre de design est l'espace dans lequel on crée ou on édite tous les designs. La 

figure suivante montre les parties de ce type de fenêtre.  

o La barre de titre (title bar) affiche le nom du projet, le nom du design, le type de 

la fenêtre et un numéro d'identification.  

o La barre de menu (menu bar) montre les menus disponibles dans la fenêtre 

courante.  

o La barre d'outils (toolbar) contient les boutons correspondants aux commandes 

les plus fréquentées et elle est configurable.  

o La liste de palette (Palette list) permet de choisir la catégorie de composantes à 

placer dans la palette de composantes.  

o La liste historique des composantes (component history drop down list) est 

continuellement mise à jour pour refléter les composantes placées dans le design. 

Elle représente une méthode rapide pour placer d'autres instances d'une 

composante du design.  

o La surface de dessin (Drawing area ) est l'espace dans lequel on crée le design.  

o La palette des composantes (Components Palette) contient des boutons des 

composantes à placer.  

o Panneau d’état (Prompt panel ) fournit les messages relatifs à l'exécutions des 

commandes 
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▪ Création du fichier de design:  

Pour créer un fichier de design il faut:  

o Ouvrir une fenêtre de schématique ou de layout.  

o Choisir la commande File > New et une boite de dialogue apparaît.  

o Choisir le nom du design.  

o Sélectionner le type de design: Analog/RF Network ou Digital Processing 

Network.  

o Sélectionner l'option New window pour créer le nouveau design dans sa propre 

fenêtre.  

o Optionnellement, on peut choisir un Design Template pour l'utiliser comme point 

de départ pour le nouveau design.  

o Cliquer sur Ok. Le programme ajoute automatiquement l'extension *.dsn au nom 

du fichier.  

 

▪ Enregistrement du fichier de design:  

Il y a trois commandes reliées à l'enregistrement de fichier: Save, Save as et Save as 

Template.  

o On utilise la commande Save pour enregistrer les changements apportés dans un 

fichier existant.  

o Save As sert à copier un fichier existant dans un nouveau fichier.  



GEN6083 - Laboratoire 1   

9 

 

o Save As Template est utilisée pour enregistrer un design pour s’en servir comme 

un fichier modèle.  

 
  

▪ Ouverture d'un design:  

Il existe plusieurs façons pour ouvrir un design existant.  

o Double clique sur le nom du design dans la fenêtre principale.  

o Utilisation de la commande File>Open dans la fenêtre de design  

o Choisir le design désiré dans la liste de fichier (File List) dans le menu File si le 

design figure parmi les quatre derniers fichiers ouverts ou à partir le menu 

Window si le design est encore en mémoire.  
 

8. Placement de composantes  

 
Pour placer une composante dans un schéma de design on doit :  

o Localiser le composant désiré et cliquer dessus.  

o Déplacer le pointeur de la souris à l'intérieur du cadre de la fenêtre de dessin et 

cliquer sur le bouton d'orientation pour tourner le symbole.  

o Cliquer pour placer le symbole à la position désirée.  

 

Lorsqu'on place une composante nécessitant une connexion électrique, la broche numéro 

1 est identifiée par (/). 
 

8.1 Utilisation de la palette de composantes 
 

La palette située à gauche de la fenêtre du design est une méthode rapide pour placer une 

composante si on connaît le nom de la bibliothèque qui la contient. Pour changer la 

bibliothèque de composantes de la palette, il faut utiliser la liste de palette ou encore à 

partir de la commande Component>Component Palette. Par exemple, pour placer 

un bout de ligne de transmission réelle de type micro-rubon, il faut choisir la bibliothèque 

dont le nom "TLines-Printed Circuit Board" disponible dans la liste de palette.  
 

8.2 Edition des paramètres d'une composante 

 
Par défaut, dans une fenêtre de schématique, la boite de dialogue nécessaire pour l'édition 

des paramètres de la composante ne s'affiche pas automatiquement. Ainsi, après avoir 

placer la composante dans l'espace de dessin, il faut double cliquer pour avoir cette boite 

de dialogue ou encore on peut se servir de la commande Edit > Component > Edit 
Component Parameters.  

Pour spécifier les paramètres d'une composante il faut :  

o Sélectionner le paramètre à changer. Il faut noter que les champs disponibles pour 

définir un paramètre dépendent du paramètre en question.  

o Changer tous les champs et les valeurs des paramètres requis puis valider 

l'opération en cliquant sur la touche Enter.  

o Cliquer sur Component options pour définir la visibilité et la portée des 

paramètres.  
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o Valider les changements apportés en cliquant sur Apply. 

 
9. Exemple de design d’un circuit passif  

 
On étudie dans ce paragraphe, l’utilisation de ADS pour la conception d’un exemple de 

circuits passifs tel que le filtre passe bande à 12 GHz à base de ligne micro-ruban. Ce 

filtre est composé d’une concaténation de deux dispositifs permettant de répondre aux 

exigences.  

 

9.1 Schéma de simulation 

 
Puisque le filtre à concevoir est à base de ligne de transmission, la première étape 

consiste à paramétrer le substrat à utiliser. Pour cela, on doit insérer au préalable un 

élément substrat, MSUB, en utilisant la palette Tline-Microstrip. Le paramétrage de cet 

élément consiste à initialiser les valeurs, par exemple de la permittivité relative εr, 

l’épaisseur H, la conductivité du métal Cond et les pertes dans le diélectrique TanD.  

 

L’étape suivante consiste à dessiner le schéma du circuit dans une fenêtre de type 

schématique. On utilise pour cela la palette Tline-Microstrip afin d’insérer des lignes 

micro-ruban simples et couplées (resp MLIN et MCFIL). Après avoir inséré chaque 

élément, un double clique dessus permet d’afficher la boite de dialogue à partir de 

laquelle on précise les valeurs des paramètres de chaque élément (exemple, W et L 

représentent respectivement la largeur et la longueur de la ligne). Pour pouvoir utiliser 

l’option de la génération automatique du layout du circuit il faut remplacer les 

terminaisons par des ports choisis à partir de la commande Component>Port.  
 

La dernière étape consiste à préciser le type d’analyse à effectuer dépendamment des 

résultats souhaités. Dans notre cas, nous avons besoin d’examiner l’adaptation à l’entrée 
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et à la sortie du filtre et ses pertes d’insertion. Ainsi, une analyse de type S-Parameter 
satisfait nos besoins.  

 

 
Figure 1 : Schéma du filtre passe-bande à 12 GHz. 

 

9.2 Schéma du layout  
Le layout du circuit du filtre a été créé automatiquement via l’utilisation de la commande 

Layout > Generate/Update Layout dans le menu de la fenêtre de design. Dans la 

boite de dialogue affichée, il faut préciser le composant qui représentera le point de 

début. Par exemple, dans notre cas, on met le composant TL1 (Starting Component = 

TL1).  

 

 
Figure 2: Layout du filtre. 

 

9.3 Affichage des résultats 
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Pour afficher les résultats de l’analyse, on doit commencer par ouvrir une nouvelle 

fenêtre d’affichage via la commande Window>New data Display. Dépendamment des 

résultats à afficher, on pourra choisir une multitude de plot (Abaque de Smith, linéaire, 

polaire…). Pour cet exemple, on a choisi un plot de type linéaire pour l’affichage de S21, 

S11 et S22 vs la fréquence.  

 
Figure 3 : Résultats de l’analyse du filtre.  

 

 
 
 


